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President's

Message: Discover Your Local Resources
by Gregg Gronlund

In genealogy, as in other aspects of our lives, we tend to like one stop shopping. Big box genealogy resources,
much the same as big box stores like Wal-Mart, Target, Costco, etc., attract us for the convenient access to so
many different products in one place, and the ability to search them all at once. We spend hours on Ancestry, or
Footnote, or Family Search. However, at varying points in our research, these resources do not provide the
genealogical answer we seek. We have to find more specialized, localized resources for our research. An important
part of our research is to discover and know our local resources. A first strategy to adopt in finding these, is to try
to find resources that have gathered together a variety oflocal resources into one place, so once again, to a degree,
we can start with "one stop shopping."
In Central Florida, one such resource is the Central Florida Memory project <www.cfmemory.org>. Here you will
find online searchable access to digitized copies of materials housed at several Central Florida institutions (the
Orange County Library System, University of Central Florida Libraries, Rollins College, the Orange County
Regional History Center, Seminole County Museum of History, Stetson University, and Bethune-Cookman
University). This website includes letters, diaries, photographs, scrapbooks, city directories, telephone books,
funeral home records, voting/elections records, and more. There is also a link to "Additional Resources." If you
click on "Share," then click on "Additional Resources," you will find links to Other Digital Collections, Central
Florida History, Central Florida Genealogy, Central Florida Libraries, and County and City web sites.
Being aware of a website like this should stimulate your genealogical research skills in several ways. If your
research is in Central Florida, this website offers some valuable resources to explore (and revisit as most of these
resources will be updated at times). If your research is elsewhere, explore to see if there is a similar project in the
geographical areas you are researching. For example, most of my ancestors settled in Clayton County, Iowa, and
St. Louis County, Minnesota. Starting at the county level, I'm exploring to see if either of my counties of interest
have institutions that have started a digitizing project similar to Central Florida Memory. In the process, I am
identifying all libraries, museums, historical and genealogical societies, newspapers and other publications, etc.,
that might have the material that is of interest to my research. At the same time, I am also looking for the same type
of resources at the state level, since the states are more likely to have the financial resources to have already
initiated a digital preservation project, which may include material pertinent to my genealogical research. Of course
one good one-stop shopping website for genealogy is US GenWeb <www.usgenweb.org>, where I have been
fortunate to find a number of obituaries and burial locations for ancestors in Clayton County, Iowa.
Another one-stop shopping website for genealogy is Cyndis List <www.cyndislist.com>. Here, too, is a good place
to start to try to find resources for your county. On the Cyndislist home page, click on the letter "U' to jump down
to United States Index. Scroll down to find your state, then click on counties. This will take you to your state's
listing of resources as gathered on Cyndislist. Scroll down to your county and you will find an excellent start to
identifying your county resources. One of these resources is <www.ePodunk.com> , whose slogan is "We believe
in the power of place." ePodunk provides in-depth information about more than 46,000 communities around the
country, from Manhattan to Los Angeles, Pottstown to Podunk. Listings also include geocoded information about
thousands of parks, museums, historic sites, colleges, schools and other places across America.
So, even when we need to be more specific in our genealogical search or to leave the grand and ever expanding
genealogical universe of Ancestry and other mega-sites or to focus on the state, county, city, or town of our
ancestors, we can still start by finding the best one-stop shopping for that locality. Then we are forced to
delightfully wend our way to those even more specific boutique and mom & pop shopping experiences, to which
our genealogical research inevitably leads us. This would include localized publications such as the Buried
Treasures you are holding in your hands right now. And if you don't know the local publications of your
geographical research area, there are one-stop shopping resources to find that, too, such as PERSI (PERiodical
Source Index) which is included in HeritageQuest online, a database available through many local libraries.
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My Brick Wall: Celia Kelly (b. 1856 in Roscommon County, Ireland)
by Mary Greer
Who is my brick wall? I'm intrigued by my maternal great-grandmother, Celia Kelly. Have you ever met
someone with whom you have an instant connection? That's what I have with Celia. She got me hooked on
genealogy.
A coworker kept talking to me about her genealogy research, and I have to admit that my eyes would glaze
over. Then one day she suggested that we use our lunch hour to use her Ancestry account and find one of
my relatives. I picked Cecilia (also known as Celia). We found her under her married name, Celia Serrage.
As soon as I saw her name on the census, I felt our hands touched.
Here is what I've been able to find out about Celia: she was born in 1856 in Roscommon County, Ireland.
In 1872 at 16 years of age she emigrated from Ireland and came to the United States through the port of
Boston. I was able to find her on a passenger list, but could find no one else on the list that had the same last
name. I hate to think of a young girl of 16 traveling alone, but it was not uncommon. Young girls were
commonly sent to America instead of their brothers, so they could send money home to support the family.
Perhaps there were other passengers from her small town or village traveling on the same ship. I would like
to think so.
I thought finding Celia was difficult, since Kelly is such a common name. However, her married name proved
even more difficult. The next time Celia surfaces after her emigration in 1872 is when she has a child in 1877.
She had married Michael Serrage and lived in Cincinnati, Ohio, but I can't find a date or location for the
marriage. I was, however, able to find Serrages in Roscommon County in Ireland. It's not a common name
and there was a family of Kellys on the same page of the Valuation of Tenements in Ireland for the time
period. Maybe that's how Celia and Michael knew each other.
In the U. S. censuses and Cincinnati city directories, I found a total of approximately eight different spellings
for Serrage. For most of the time that I was tracking Celia during her married life, there was also another man
whose name was Michael Serrage. living in Cincinnati as well!
Celia had four sons, with the last one born in 1884. Just two years later, her husband dies of heart failure at
the age of 40. In the Cincinnati city directories he was always listed as a laborer. I finally knew I had the right
Michael Serrage when the address on the interment records matched an address in the 1886 Cincinnati city
directory.
A little over six months after Michael Serrage's death in 1886, Celia is forced to place her four boys in St.
Joseph's Orphanage in Cincinnati. What a heartbreak that must have been. The orphanage is still in operation
and they sent me a copy of the admission entry for the four boys. It reads as follows: "Father dead. Mother
not able to keep them, but is willing to contribute something to help to support them. Rev. R. Doyle gave
note." The boys were released to their mother's care in July 1888, so they spent a little less than two years
separated from their mother. What a joyful reunion that must have been!
I next found Celia in the Cincinnati city directories of 1887-1890 working as a laundress in the Cincinnati
Orphan Asylum and the Palace Hotel (which is still in operation under the Cincinnatian Hotel name). I was
able to find a picture of the hotel when Celia worked there and even found an advertisement from that time.
Rooms then went for $2 and $2.50 and the hotel had a shared bathroom at either end of each corridor of each
floor. Talk about luxurious travel!
At some point in 1890 Celia marries a man by the name ofJohn or James Griffin. I can find no record of the
marriage, but my grandmother is the product of this second marriage. My mother said she remembers her
mother saying that Celia went back to Ireland and came back with a husband, but I can find no evidence to
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support that. If that's true, I wonder if she told him about the four sons back home first?
In 1893 Celia loses her youngest son to consumption, not an uncommon illness during that time. He was 13
years old and his occupation on the death record lists him as an errand boy.
I have not been able to find Celia's husband in any records, so I don't know what became of him. Did he die
or leave? Trying to sort through Ancestry for a James or John Griffin is a daunting task that I haven't tackled
yet.
My last record for Celia is a death certificate in 1909. She was only 53 years old; cause of death was
pneumonia. I was able to find Celia's unmarked grave in a Catholic cemetery in Cincinnati. My siblings and
I are planning to put up a marker for her. We think she deserves it.

Obituary of Rachel Wilson, Lincolnville, IN - 1895
Rachel Wilson, whose funeral occurred at Lincolnville on Thursday, January 31, 1895, sister of Barclay
Thorne of Laf'ontaine, and J. B. Thorne of Wabash, Indiana, was born in New Jersey in the year, December
1, 1833, and came with her parents, Josiah and Hannah Thorne to Indiana in 1845, and to Wabash County
in 1849.
She was married to George Jennings, in 1850, at the tender age of seventeen. Jennings died in 1855, leaving
two children, Jobie Jennings and Flora Jennings.
She then married William Jennings, an uncle to her first husband, who also died in a few years, leaving her
with four children - Flora and Job Jennings by her first husband, and Jane and Jimmie Jennings. She was then
united to Rev. Arthur Jackson who lived but a short time leaving an additional daughter, Beatrice (Tressie)
Jackson to her care.
For the fourth time she gained a companion and protector by marrying Eli Wilson of Lincolnville, who was
her senior by 20 years, and from this union two children were born. These children all survive, except one,
and were present at her funeral.
For years she was an intense sufferer from a tumorous formation which was successfully removed by an
operation a few years ago, and was found to constitute 1/6 of her normal weight. Through all these
diversified in the midst of suffering and sorrow and the solitude which beset her earthly career at every turn
-like the old patriarch of the sandy District ofUz, her life seemed to submit and say, "The Lord gave and the
Lord taketh away. Blessed be the name of the Lord". She murmured not nor did she complain. She died in
peace, and today is a sainted mother in the abode of the blessed wherever they may be.
Her funeral took place from the M. E. Church; services conducted by Rev. John R. Brown.
Among the relatives in the audience was noticed the aged and hoary aunt of the deceased, Hannah Robberts
of Ridgeville, who has been a trumpeter upon the walls of Zion and is still pointing and piloting the weary
traveler to a rest beyond the clouds.
(Clipping from the Wabash Plain Dealer).
Note in pencil: "Pallbearers were: Maude Wilson, Jessie Hummer, Cora Wilson, Minnie Jennings, Aida
Vickery, Daisy Darrow"
From the Wabash Co, IN mailing list. Submitted by Ann Osisek, with the comments "found it very interesting
with the multiple marriages, etc."
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Creating a Family Structure: James M. and Martha (Eaves) Wallace
Rutherford County, North Carolina
by Blanche M. Wallace
Data collected over the past six years has been used to create a hypothetical family for this couple. James
appears in the household of an apparent son, Toliver Wallace, in 18601. No documents have been found that
prove the names of his children.
The procedure used to construct this family is based on a method described by Michael John Neill? It will
start with analysis of the Rutherford County, North Carolina, census records for James Wallace's household
for the years 1810 through 1840. This will help to initially simplify the process by establishing the most likely
number and ages of children. Later this structure will be compared to other records to see how they fit with
the census findings.
Before beginning the analysis of these pre-1850 census records, certain assumptions and one very important
caution should be established. Another researcher may use different assumptions to conduct similar analyses.
The important point is that the assumptions be recorded and kept in mind while conducting the analysis.
Caution: when an age range is stated in the census as "of 10 and under 20 years of age", this gives an actual
age range of 10 to 19 years as of the date of the census. If, however, the 19-year old had not had a birthday
as of the census date, he or she would turn 20 later in the year, meaning he/she had been born 20 years before
the census year. For example, a female in the 1830 census may be 19 at the date of the enumeration and turn
20 later in the year, meaning she was born in 1810 rather than 1811. So, it is important to remember that the
end years on the birth ranges are not necessarily exact.
Assumptions:
1) The census ages are correct and consistent for each person from year to year. This is not necessarily a valid
assumption but is needed to perform the analysis.
2) Children born to the head of household were enumerated in his household until they died, married or
established their own household.
3) There were no multiple births. If three children are listed with the same age range, they represent three
different ages.
4) The analysis is conducted to minimize the number of people who lived in the household during the entire
time period that is being evaluated.
James Wallace obtained a Rutherford County, North Carolina, marriage bond in 1808 to marry Martha
(Patsy) Eaves. 3 His bondsman was William Mullins. James was head of household in the Rutherford County
census enumerations for the years 1810, 1820, 1830, and 1840. In 1860 he was enumerated in the household
of Toliver Wallace. Although other documents prove he was alive in 1850 and 1870, he has not been located
in the census for those years in any state. He served in the War of 1812; however, he did not see action. He
traveled from Rutherford County to Marietta, Cobb County, Georgia, on at least two occasions. He was
physically and mentally capable until at least age 87. His date and place of death are unknown, but he
probably died in Marietta, where he lived in 1871. Documentation of these and other of his life events is
presented in the following pages.
Analyses of the 1810-1840 census records for Rutherford County, with conclusions, are given below.
Comments are in italics.
1810 Census"
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1 white male under age 10 - a boy, born between 1801 and 1810 - Son A.
1 white male age 16 through 25 - presumably James, born between 1785 and 1794.
1 white female age 16 through 25 - presumably Martha, born between 1785 and 1794.
Additionally, the census shows the household had one loom and produced 200 yards of homespun valued at
$100.
1820 Census'

1 white male under age 10 - a boy, born between 1811 and 1820 - Son B.
1 white male age 10 through 15 - a boy, born between 1805 and 1810 - Son A.
1 white male age 16 through 25 - a boy born between 1795 and 1804, possibly a brother or
brother-in-law to James or Martha. He was not present in their household in 1810; nor is he present on
any subsequent census for this family.
1 white male age 26 through 44 - presumably James, born between 1776 and 1794.
3 white females under age 10 - three girls born between 1811 and 1820 - Daughters A, B, & C,
with A the eldest and C the youngest.
1 white female age 26 through 44 - presumably Martha, born between 1776 and 1794.
The 1820 census also indicates there were 3 persons in the household employed in agriculture.
1830 Census"
I

1

,.

Ii

f

"

1 white
1 white
1 white
2 white
2 white
1 white
1 white
1 white

male age 10 through 14 - a boy, born between 1816 and 1820 - Son B.
male age 20 through 29 - a boy, born between 1801 and 1810 - Son A.
male age 40 through 49 - presumably James, born between 1781 and 1790.
females under age 5 - two girls, born between 1826 and 1830 - Daughters E & F.
females age 5 through 9 - two girls, born between 1821 and 1825 - Daughters C & D.
female age 10 through 14 - a girl, born between 1816 and 1820 =Daughter B.
female age 15 through 19 - a girl, born between 1811 and 1815 - Daughter A.
female age 40 through 49 - presumably Martha, born between 1781 and 1790.

1840 Census 7

I

.~~~4'"

r.

~~J.I~I' I'· I ' I'; I~r ' I~ I: I: ~~ I~ I/ I~r, J~ I, 1,/I II

2 white males under age 5 - two boys, born between 1835 and 1840, presumably children of
other parents. If the boys were four years old in 1840, Martha would have been 45-50 when they were
born.
1 white male age 50 through 59 - presumably James, born between 1781 and 1790.
1 white female age 10 through 14 - a girl born between 1826 and 1830, Daughter E or F.
2 white females age 15 through 19 - two girls born between 1821 and 1825, Daughters C & D.
1 white female age 50 through 59 - presumably Martha, born between 1781 and 1790.
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Estimated birth year range for James and Martha
Census
Year
1810
1820
1830
1840
Charting the birth year ranges from the above census records indicates the earliest birth year for James and
Martha would be 1785 (1810 census) and the latest would be 1790 (1830 and 1840 censuses). Of course, this
holds only if Assumption No.1 is valid (the census ages are correct and consistent for each person from year
to year). Keep in mind the caution regarding the person's birth date relative to the census date. At the time
of the 1810 census, if James or Martha was 25 but had not had a birthday, he/she would turn 26 later in 1810,
making his/her birth year 1784.
Estimated birth year ranges for two apparent male children.
Year
1810
1820
1820
1830
1830
It appears there were at least two sons born to James and Martha. Since they married in 1808 and only one
son (A) was in their household in 1810 (less than 10 years of age), the male enumerated on the 1820 census
as born 1795-1804 was not likely their child.
Son A, born between 1805 and 1810
Son B, born between 1816 and 1820
Estimated birth year ranges for six apparent female children.
Year
1820
1820
1820
1830
1830
1830
1830
1830
1840
1840
1840

181

It appears that there were at least six daughters born to James and Martha between the years 1811 and 1830.
Martha would have been 35 to 40 in 1825 and 40 to 45 in 1830, the latest year by which Daughters E and F
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could have been born. This time frame is consistent with the end of child-bearing for most women (early to
mid-40s). By the 1840 census, daughters A, B and either E or F had left the household. Since daughters E and
F are estimated to have been born between 1826 and 1830, the oldest they could have been in 1840 was 14;
15 ifborn in 1825. The missing daughter ElF either married very young or died. Or, perhaps she was just away
from home on the census date and the informant failed to mention her name.
Daughter
Daughter
Daughter
Daughter
Daughter
Daughter

A, born between
B, born between
C, born between
D, born between
E, born between
F, born between

1811 and
1816 and
1821 and
1821 and
1826 and
1826 and

1815
1820
1825
1825
1830
1830

Identifying the children of James and Martha (Eaves) Wallace
A theme that ties these persons together is the occupation of masonry. James, his probable sons, and sons-inlaw were all brick and stone masons, either part or full time. Two, H. B. Wallace (probable Son B) and
probable son-in-law, Nathaniel Spencer Eaves (husband of Ursilla Wallace), established construction
businesses. All the probable children discussed below moved to Marietta, Cobb County, Georgia, or adjacent
Fulton County between 1848 and 1852, except Toliver (probable Son A), who arrived about 1866. James was
in Marietta in 1855 when he applied for bounty land based on his service in the War of 1812.8 He was there
in 1871 when he applied for a pension based on the same service." It is believed that Martha died there on 02
September 1842.10 If so, this means she and James were in Marietta by that date. It would explain why she
is not found in a census after 1840. In 1840 there were five households in Cobb County with the surname
Wallis (Wallace spelling not found). The only one in General Militia District 898 (Marietta) was Jesse Wallis. 11
The family included one white male, age 50-59, presumably, Jesse. This age range is the same as that ofJames
Wallace in 1840, indicating Jesse might be a brother. Neither Jesse nor James was found on the 1850 census
for Cobb County.
Son A born between 1805 and 1810. This son is almost certainly Toliver Wallace, born about 1808-09. The
ages that Toliver gave on the 1850,12 1860,13 1870,14and 188015 census indicate a birth year of 1809, 1808,
1807, and 1809, respectively. He married Nancy Dycus in 1833, Rutherford County, North Carolina. 16In the
1860 census their household included a James Wallace, age 76 (born circa 1784). James is the correct age to
be the James Wallace who married Martha Eaves in 1808 and he fits into the age range for the head of
household in the census records discussed above. Toliver, Nancy, and most, if not all, their children moved
to Cobb County about 1866. Harbird B. Wallace (probable Son B) stood security for Toliver's son, Toliver,
when he posted bond for constable in two elections in the 1870s.17
Son B, born between 1816 and 1820. This son is almost certainly Harbird B. Wallace. There is no document
to prove that Toliver had a brother by that name, but family tradition plus the circumstantial evidence is
compelling. According to his grave marker, H. B. was born in 1813.18 However, his age on the census for
1850/9 1860/0 1870,21 and 188022 indicates an approximate birth year of 1815, 1818, 1816, and 1816,
respectively. This fits with the birth year range established above for Son B. He served with Toliver on road
crews in Rutherford County, North Carolina, in 1837,23 1839/4 1842/5 and 1844?6 He married Martha
Johnson there in 1845.27H. E. McGinty, husband of Nancy Wallace, was his bondsman. Family tradition says
that he arrived in Marietta, Georgia, in the mid-1840s. In 1848 he appeared on a Cobb County Tax Digest for
Marietta District" and he voted in an election there in 1849.29He and Toliver took the Oath of Allegiance to
the United States in the 898 Election Precinct of Marietta on the same date in 1867.30 H. B. was frequently
referred to as "Bird Wallace" and has always been remembered in my family as "Uncle Bird". His many
documented construction projects in Cobb County include two courthouses and the wall around the National
Cemetery in Marietta. 31
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The daughters of James and Nancy are, of course, more difficult to identify. However, there is enough
circumstantial evidence available to make a strong case for the women discussed below. First, a table (Exhibit
A) was created for all females with the name Wallace (and its spelling variations) who married in Rutherford
County, North Carolina, between the years 1820 and 1868.32 Second, all the women whose parents could.be
determined to be other than James and Martha were eliminated. Ofthose remaining, research indicates that
the following (Elizabeth, Ellen, Martha, Nancy, and Ursilla) were probably daughters of James and Martha.
Only one Wallace bride (Jane A. married William H. Groves in 1839) could not be placed with her parents.
She was born about 1811-12 based on the one census record that could be found for her (1850).33 This birth
year doesn't fit with the family structure illustrated by the census records discussed above. This analysis
indicates that one daughter was born to James and Martha between 1811 and 1815. She has been almost
certainly identified as Elizabeth (Wallace) Bedford.
Daughter A born between 1811 and 1815. Elizabeth Wallace was born 27 February 181134 She married
John Hawkins Bedford in 1835, Rutherford County." F. W. Lee was the bondsman. By 1849 Elizabeth
and John were in Marietta." At the time of the 1860 census Elizabeth was widowed." On 05 June 1871
Elizabeth purchased land in Marietta from H. B. WalIace38 In the 1870 census" she lived next door to him
and in 188040 she was the second door down from him. She named a son Harbird." She named three
daughters Martha, Nancy, and Ellen.42 She died 21 January 1886 near Marietta." Close to the markers for
Elizabeth and John Hawkins Bedford in Marietta City Cemetery is one for Martha Wallis, died 02
September 1842.44It is tempting to think that this is the final resting place of Elizabeth's mother.
Daughter B. born between 1816 and 1820. Ellen Wallace was born 17 April 1816.45 She married Abner G.
McEntire in 1839, Rutherford County." The bondsman was Bartlett Henson. From 1839 through at least
1842, A. G. McEntire was involved in a law suit. H. B. Wallace was security for him." A. G. and Ellen appear
on the 1850 census in Rutherford County." By 1852 they had moved to Georgia" and in 1860 were
enumerated in Atlanta, Fulton County. 50Ellen named a son Harbird Hawkins McEntire and a daughter,
Elizabeth. 51Ellen died 03 January 1863 and A. G. died 20 June 186552
Daughter C. born between 1821 and 1825. This daughter is unidentified and is placed here on the basis of the
age gap between Ellen (born 1816) and Martha (born 1823). She was present in the James Wallace household
in 1840.
Daughter D, born between 1821 and 1825. Martha Wallace was born in July 1823, according to the 1900
census. 53Ages she gave in three offive census records support this time frame. In 185054she was age 26 (born
1824); 186055,age 36 (born 1824); 1870,56age 40 (born 1830); 1880,57age 53 (born 1827); and, 1900,58age
76 (born 1824). She married James McGinty (brother of Henry E.) in 1845, Rutherford County, North
Carolina. 59A. G. McEntire, husband of Ellen Wallace, was bondsman. In 185060Martha and James were in
Marietta, Georgia; in 186061and 187062they were enumerated in Atlanta. In 188063they were in Hall County,
Georgia, where they died; James in 1889 and Martha in 190064 Their son, Manassah B. McGinty, was in
business with Nathaniel Spencer Eaves, husband ofUrsilla Wallace and his relationship to the Wallaces of
Marietta is mentioned in one of his obituaries." Both men were stone masons who went on to develop
successful construction companies.
Daughter E. born between 1826 and 1830. Nancy Wallace's birth year is uncertain. Henry E. McGinty
obtained a Rutherford County marriage bond dated 29 December 1840, with A. G. McEntire (Ellen Wallace's
husband) as bondsman." Nancy's age was 22 in 185067 (born 1828, married at 12); 35 in 186068(born 1825,
married at 15); 42 in 187069 (born 1828, married at 12); 54 in 188070 (born 1826, married at 14). Given the
marriage bond date, she should have been enumerated in the household of James and Martha in 1840;
however, she may be the young daughter missing from the 1840 census. There are no McGinty households
on the 1840 enumeration for Rutherford County, so her location can't be speculated upon. By 1850, Nancy
and Henry were in Marietta." Henry died in 1852 and H. B. Wallace was appointed administrator of his
Buried Treasures

Central FL Genealogical Society
9

Vol. 43, No.1

estate." He gave a bond of $2000 with Benjamin Johnson as security (probably a relative ofH. B.'s wife,
Martha Johnson). In January 1859, Nancy gave bond of $1400 and was appointed guardian of her five
underage children." Her security was B. S. Johnson (presumably the same man, based on essentially identical
signatures on both documents). By 1860 she was married to David Henry White and living in Alabama with
all of her children except James." In 1866, her eldest son (James E. McGinty) gave bond of$1000 and was
appointed guardian of three underage siblings." His security was Nat. S. Eaves (husband ofUrsilla Wallace).
Nancy's date and place of death are unknown. Henry E. McGinty is buried in Marietta City Cemetery."
Daughter F, born between 1826 and 1830. Ursilla Wallace was born about 1829. She could not be located
on the 1850 or 1870 census. In 186077 she was 31 years old (born 1829) and in 188078 she was 51 (born
1829). She married Nathaniel Spencer Eaves in 1846, Rutherford County, North Carolina." The bondsman
was John M. Scoggin. By 1849 they were in Marietta, Georgia, when N. S. Eaves was listed on the Tax
Digest for that year. 80 Ursilla and N. S. Eaves were enumerated in Marietta in 1860.81 As noted above, N. S.
Eaves was security for James E. McGinty's guardian bond in 1866. In 1869, the Treasurer of Bartow County,
Georgia, was directed to pay the firm of Eaves & McGinty thirty dollars for building two chimneys at the Poor
House." N. S. Eaves established a thriving construction business with M. B. McGinty and they worked in
many areas of the state. 83 M. B. McGinty was a son ofJames and Martha (Wallace) McGinty. N. S. and Ursilla
were enumerated in Bartow County in 1880.84 Ursilla probably died between 1885 when a newspaper article
noted that she had suffered an accident" and 1895, when N. S. Eaves remarried. 86 He died in December 1898;
neither wife is mentioned in the various obituaries for him." He and Ursilla are probably buried in Oakhill
Cemetery, Cartersville, Bartow County, Georgia, where members of their family are known to be interred.
Ifpersons with evidence to prove or dispute this hypothetical family will contact the author, revisions will be
made. I am grateful to Mr. Miles Philbeck, Editor, Bulletin of the Genealogical Society of Old Tryon County,
for his suggestions and guidance and to Betty Jo Stockton, Editor, Buried Treasures, Central Florida
Genealogical Society, for her editorial advice. The information that has been gathered on the lives of these
probable children of James and Martha (Eaves) Wallace will be discussed in detail in an upcoming book on
my Wallace ancestors, their families, and collateral kin.
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of Rutherford County; North Carolina, 1779..1868. Baltimore,MD,USA:Genealogical
PublishingCo., 1986.
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Ed. Note: Blanche's research, analysis and documentation
is a great example of the proper way to present data;
wish I could be so thorough. The article is reproduced in its entirety, as splitting it between issues would be less
effective.
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Error Checking in Family Tree Maker
submitted by Gene Clark
While Family Tree Maker cannot determine the accuracy of specific biographical information, such as the
spelling of your relatives' names, it is able to identify facts that conflict with each other. We encourage you
to use the error checking features so that your family information is as accurate as possible.
Family Tree Maker does some error checking automatically, while other types of error checking you initiate
yourself. Family Tree Maker's three error checking techniques are described below.
Data Entry Checking.
The Find Error Command.
Data Errors Reports.
Data Entry Checking
Family Tree Maker automatically checks your information as you enter it. When Family Tree Maker finds
information that seems to be incorrect or conflicts with other information in your Family File, it prompts you
to take a closer look at it and fix it, if necessary.
The Data Entry Checking feature can identify many different types of errors, and it automatically checks for
all of them unless you have chosen not to have it look for certain types. For some types of errors, such as
random punctuation in a name, you can't turn the error checking off; Family Tree Maker always prompts you
to fix these errors.
You can use the Error Checking dialog box to change which errors Family Tree Maker looks for:
From the File menu, select Preferences and then choose the Editing tab. Look for the section labeled Errors
to check during data entry.
Family Tree Maker displays the Error Checking dialog box.
Select the check boxes for the types of errors that you want Family Tree Maker to look for.
Click OK when you've made your changes.
Family Tree Maker closes the dialog box.
The Find Error Command
Using the Find Error command is similar to spell-checking a word processing document: Family Tree Maker
takes you through your file from beginning to end, showing you possible mistakes and allowing you to fix
them.
To check your Family File with the Find Error Command:
From the Edit menu, select Find Error.
For FTM 2005-2006: From the Tools menu, select Find Error.
Family Tree Maker displays the Find Error dialog box. Each of your options is described below.
Errors to find in search -- Put checks in the boxes for the types of errors that you want Family Tree Maker
to locate.
Reset all ignored errors -- If you previously chose to ignore some errors by selecting the "Ignore error" check
box, described in step 3, click this button to include those errors in all future searches.
Click OK when you've made your selections.
Family Tree Maker begins your error search.
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When Family Tree Maker displays an error dialog box, you can either fix the error manually, fix it
automatically by clicking AutoFix, or skip over it by selecting the Ignore error check box. When you select
"Ignore error," Family Tree Maker flags that error so that it will not show up as an error in other places in
your Family File and in subsequent searches.
Click Find next when you want to move on to the next error or click Close when you want to quit searching.
You've reached the end of the search when Family Tree Maker returns you to a Family Page.
Sample Error Checking Dialog Boxes
The error checking features in Family Tree Maker search for many different types of mistakes in names and
dates. When Family Tree Maker locates a possible error, it displays a dialog box so that you can either fix the
error or skip over it if it is not an error. There are five different types of dialog boxes, but they all work in
fundamentally the same way.
; In the dialog box here, Family Tree Maker
. believes that too many letters in the name are
capitalized. To fix the error when you are
using the Find Error command, you would
re-type the name and then click Find Next to
move on to the next error or click Close to
quit the search. To fix the error when you are
using Data Entry Checking, all you need to
do is re-type the name correctly and then click OK. ("OK" is not visible in the dialog box displayed here.)
Alternatively, you could click AutoFix. In this case, Family Tree Maker would make its best attempt at fixing
the error for you. When you click AutoFix, the button name changes to Undo so that you can reverse the
change if Family Tree Maker fixed the error incorrectly.
If the name actually was capitalized correctly, you would select the Ignore error check box. This way, Family
Tree Maker would not display this error for this individual again.
Data Errors Reports
A Data Errors report can show you all of the places in your Family File where there might be mistakes. It is
very thorough in its checking, but it does not use the dialog boxes described above to show you your mistakes.
Instead, you get a printed report and then you have to go into your file and manually locate the errors listed
in the report.
To create and print a Data Errors report:
From the View menu, select Report.
Family Tree Maker displays the last report you created.
From the Format menu, select Report Format.
Family Tree Maker displays the Report Format dialog box.
In the Select a format for your report list, click Data Errors.
Click OK after making your selection.
Family Tree Maker returns you to the Report view.
Once your Data Errors Report is on the screen, you can print it. Simply turn on your printer, and then from
the File menu, select Print. For each potential error that Family Tree Maker finds, the report lists the name
of the individual that the error is associated with, that individual's birth date, and the error.
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To fix one of these errors, locate the individual in your Family File that the error is associated with. An easy
way to do this is to press F2 to open up the Index of Individuals and then type the individual's name in the
Name field. This will scroll the list of names to that individual. If you have more than one person in your
Family File with the same name, be sure to select the correct one. Once you have located the correct
individual, double-click their name to go to their Family Page. From their Family Page, you should be able to
locate the information that needs to be fixed.
You will see from the Data Errors Report that Family Tree Maker can locate a wide variety of error types.
To see a complete list ofthe errors that Family Tree Maker can find, see the "Error Checking" section of your
Family Tree Maker manual or Help system. Each error message is listed in bold and is followed by a brief
explanation and a suggestion for correcting it.

When Irish Research Comes To An End
submitted by Sallie Belperche
There comes a point when all research in Ireland comes to a halt. Records disappear, are not kept or are lost,
burnt or blown up and hopes dwindle. It is then time to forget lists of names on paper and get out and explore
the country from end to end. Soaking up the culture, countryside and social history. Talking the family off the
page and putting it back into the farms or cottages. Following it through the years. The despair ofthe famine,
hope of emigration and the turbulent political history of those remaining behind.
Above all listen to the many stories, sharing the laughter, friendliness, warmth, music and song and in all
this somewhere will be the faint echo of an ancestor calling.
Irish people have long memories and it is such a close knit society that you often find details of your family
from many unexpected sources. We found a present day farmer who remembers his Father liking our
Grandfather, as he was one of a few Protestants who would deal fairly with Catholics and as a result the
farmer was prepared to guide us for miles to meet people who knew our Grandfather and his family and
could help to flesh out the dry details obtained from the records.
The discovery from a meeting with a stranger in a churchyard that your entire family signed the pledge and
to this day there are forty, noisy, friendly newly discovered cousins delighted to meet you and share the
craie and leaving after hours of enjoyment in their company you realised that they are all still teetotal and a
day of talk and laughter was sustained with copious cups of strong tea, is an absolute pleasure.
You hear dark stories of farms that failed and a farmer and his eldest son hanging themselves in a great
uncle's farm. Which has since been left empty for seventy years and when visited is a desolate house
surrounded by gloomy trees and bushes with a chilling atmosphere from which shivering you turn away.
So when records fail, go there and talk to people, get drawn into the country and eventually travel from
end to end, stay in B & Bs and learn first hand what books and records can never tell you.
Angela Crabtree
Reproduced by kind permission of The Coventry Family History Society
Sallie says: "This article gives heart to the brick walls!"
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Orphans of William Pryor, Rutherford County, NC - 1819
submitted by Blanche Wallace

Family History Library Microfilm #428856
Minutes, Pleas & Quarter Sessions
Rutherford County, North Carolina 1818-1837
First volume on reel (volume not numbered), page 248
July Court 1819
"Ordered by Court that the sheriff bring into
next court Nancy, Lila, Jemima?, Elizabeth, John &
Nella Pryor orphans ofWm Pryor in order that the Court may provide for them"
Note: no record of the Pryor orphans found in Oct 1819, Jan 1820 or April 1820 Court minutes.
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Dropbox for Genealogists
by Betty Jo Stockton
Are you using more than one computer - and going crazy trying to make sure
that they all have the same information? Or do you have photos or data you'd
like to share easily with specific folks? Would you like to be sure that you
always have an off-site backup of your data? If so, then the free Dropbox
application may be the answer.
Dropbox is a small application that saves you immense amounts of time and
effort. Once set up, Dropbox becomes just another folder on your PC - or
your Mac, iPad, smart phone, or any other computing device that can display
documents. Your files are stored both locally in your Dropbox folder and
online on the service's servers. Dropbox lets you back up, share, and sync any
file merely by dragging the file into the Dropbox folder on your desktop. Any
changes made to files in Dropbox are automatically updated in all other linked
Dropbox folders in other devices, as long as you are connected (or when you reconnect) to the Internet.
Connecting to the Dropbox Web site gives you access to your files from any Web-connected computer and
any Web browser. And when you edit a file, it's updated on all of your devices that have a Dropbox folder.
This means that I can work on my PAF data or update my book-in-progress at the Family History Center, save
it to my Dropbox folder and, when I get home, it will synch to my desktop and both will be up to date. Or,
I can take a picture of a document at the library using the camera in my Android smart phone, store it in the
Dropbox folder on the phone and it will be accessible from all of my computers.
IfI store my genealogy data in the Dropbox folder on my computer, I can open it on any of my computers,
my smart phone or log in to the Dropbox website to open it on any computer I happen to be using (using my
password to access it).
If you want to share a folder with friends or colleagues, all they need to do is install a small Dropbox app. You
use the Share Folder option and enter their e-mail address into a dialog box. Once they've received a Dropbox
message, that folder - with its contents - appears in their Dropbox folder. Dropbox secures all data with
AES256 encryption as it's moved over the Internet and also encrypts the data on its servers.
My son in Pittsburgh writes apps for the smart phone, "drops" them into a shared file in Dropbox and I test
them out - if it can be broken, I can do it. I can take a batch of family photos, store them in Dropbox and
"share" them with everyone quickly, no matter where they are in the world. It is so much easier than trying
to email photos and files.
All files stored in your Dropbox folder are stored "in the cloud" (online) as well as on your own computer.
Thus, if your computer crashes, the data can be restored from the online storage. With tornados in the Midwest, hurricanes in Florida, flooding on the Mississippi and wildfires everywhere, it is nice to know that your
data is backed up somewhere else. All files are encrypted, so your data is safe from prying eyes.
Dropbox offers 2 gigabytes of file storage for free. If you take their tour or invite others to sign on, you can
get more free storage. Check it out at www.dropbox.com. For more information, see the Dropbox tour at
http://www.dropbox.com/tour.
One word of warning - you can only be working on the file in one place at a time. So be sure to save and close
your file at home, before you plan to work on it somewhere else.
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Obituaries found in CFGS files
These obituaries were discovered in old CFGS files. Many of these were CFGS members If you'd like a copy
of any of them, contact the Society at CFGS@cfgs.org.

Obituaries on file wrth the Central Florida Genealogical Societj
Year of
Death

Age.u
Death

Gender

1999
2004

64
83

F
M

not stated
Illinois

2007
1997
2004
2006

95
77
84
91

F
M
F
M

Michigan
Georgia
not stated
New York

1999

66

F

Indiana

1998
1997

71
34

M
M

not stated
Florida

1999
2002

89
87

F
F

Kentucky
Indiana

1997
1997

78
94

F
F

New York
Pennsylvania

2004
2004
1997
1998

82
81
81
87

M
M
N
F

not stated
Georgia
Rhode Island
Maine

realtor, died Tenn.
worked for FAA
ne..••
vspaper manager
civil service

1998
2005
2004

79
48
83

M
F
F

New York
Florda
Australia

medical doctor
memory card
memory card/photo

1999

88

F

Ohio

2003
2003
2006

80
50
87

F
F
F

New York
not stated
Georgia

artist
school teacher
homemaker

Ratcliff, John
Rudd, Robert J.

2003
1997

82
80

M
M

not stated
Iowa

military veteran
Air Force One pilot

5
Smith, Marjorie Haselwood
Sowers, Kenneth M.
streeter, Bertha Moulton Kidd

2001
1996
2004

86
83
87

F
M
F

Oklahoma
New York
Maryland

school teacher
military chaplain
artist/draftsman

2004

83

M

not stated

minister, died Penn.

2004

90

M

Florida

2000
1997
2003
1991
2004

78
90
79
68
78

F
F
M
F
F

South Carolina
Idaho
Tennessee
Michigan
Pennsylvania

NalTE

Where
Born

oornrrerrts

B
Breausche, Alice
Brolaw. Bergan F. (M.D.)
C
Carr, Margaret
oeto, Hansel J.
Cobia, Alberta Louise Tillis
Coggshall, Millard
F
Ferree, Barbara A.
G
Gale, Jack Lawrence
Gasti, Rafael Harris
H
Horning, Mary Clyta Brown
Hosier, Elma Launa McNamara
K
Keane, Madeline
Kille, Frances H.
L
Lavinghousez, Bill (Senior)
Layton, William G.
Lemoine, Eugene F.
Lougee, fvlarion D.
M
Miles, George G. (MD.)
Miller, Tanya C.
Morris. Beulah

memory card
medical doctor
minister's wife
school teacher
secretary
beekeepet/genealogist
genealogist

accidental

death

school teacher
retail sales manager
nurselHindenburg
weaver

N
Nolle, Helen W.

homemaker

p
Parnes, Arlene Lila
Parrish, Leila
Parrish, Leona

R

T
Tyson, Earl (Reverend)
V
Viehman, Newlon Byard "Byrd"

farmer/rancher

W
Ward, Elizabeth Hemphill
Ward, Sarah H.
Weingartner, V'Jiliiam "Bill" B.
Westenhofer, Dorothy McAdams
Willis, Eileen Brookhart

memory card
school teacher
airline industry
memory card
obit & memory card

A digital copy of any item can be requested by sending an ernan to cfgs@cfgs.org
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Index

17
Adams
Adkins
17
Allen
13
Baker
17
Barrington . . . . . . . . . . .. 18
Bath
18
Bedford
9, 13
Belperche
16
Brinsfield . . . . . . . . . . . .. 17
Brokaw
21
Brown
4
Buckland . . . . . . . . . . . .. 18
Burrowes. . . . . . . . . . . . . 18
Callahan
13
Carr
21
Cato
21
Cherry
13
Clark
14
Clarke
18
Cobia
21
Coggshall
21
Crabtree
16
Dalton
13
Darrow
4
Dobbins
13
Drake
18
Dulaney
17
Dycus
8
Eaves
5,9
Eaves
8,10
Ferree
21
Freeman
13
Gale
21.
Gasti
21
Greer
3, 13
Griffin . . . . . . . . . . . . . . 3, 4
Griffith
17
Gronlund
2

Buried Treasures

Groves
Groves
Hale
Handy
Henson
Horning
Hosier
Hummer
Jackson
Jennings
Jerrard
Johnson
Justice
Justis
Keane
Kelly
Kille
Kinslow
Lavinghousez
Layton
Lee
Lemoine
Long
Lougee
McEntire
McGinty
McGinty
Meeker
Melendy
Miles
Miller
Mode
Morris
Mueller
Mullins
Naumann
Neill
Nolle

13
9

13
17
9, 13
21
21
4
4
4
18
8, 10
13
13
21
3
21
17
21
21
9
21
13
21
9
9. 10, 13
.
17
18
21
21
13
21
18
5
18
5
21
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Osisek
4
Otway
18
Parnes
21
Parrish
21
Philbeck . . . . . . . . . . . . .. 10
Porter
13
Prochzka . . . . . . . . . . . .. 18
Pryor
19
Ratcliff
21
Robberts
4
Rudd
21
Russell
17
Schoenau . . . . . . . . . . . .. 18
Schulze
18
Scoggin
10
Serrage
3
Smith
17, 21
Sowers
21
Stafford . . . . . . . . . . . . .. 13
Stockton . . . . . . . . .. 10, 20
Streeter . . . . . . . . . . . . . . 21
Thorne
4
Tyson
21
Vickery
4
Viehman
21
Voetberg . . . . . . . . . . . .. 18
Wallace
5, 8-10 13, 19
Wallis
9, 13
Ward
21
Webber
18
Weingartner . . . . . . . . . . . 21
Wells
13
Westenhofer
21
White
10
Willis
21
Wilson
4
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or current resident

Genealogical Humor
My family tree is a few branches short!
My ancestors

All help appreciated

must be in a witness protection

program!

Shake your family tree and watch the nuts fall!
My hobby is genealogy, I raise dust bunnies as pets.
How can one ancestor

cause so much TROUBLE??

I looked into my family tree and found out I was a sap ..
I'm not stuck, I'm ancestrally

challenged

I'm searching for myself: Have you seen me?
Isn't

"'

genealogy fun? The answer to one problem, leads to two more!
Any family tree produces some lemons, some nuts and a few bad apples

